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Cell-Cycle Analysis Using the BD FACSArray™ Bioanalyzer

Introduction
Somatic cells proliferate to support tissue and organismal
growth and to replace damaged cells. In the case of adaptive
immunity, T and B lymphocytes divide and differentiate in
response to foreign antigenic stimulation, known as clonal
expansion and differentiation. This hallmark response
ensures that sufficient numbers of antigen-specific effector
and memory lymphocytes arise to successfully deal with the
offending antigen (eg, pathogenic microbes, viruses). For this
reason, flow cytometric analysis of lymphocyte activation
and proliferation (cell-cycle entry and progression) and
differentiation is featured in many immune function studies.
The BD FACSArray™ bioanalyzer is designed to perform
analysis of cellular samples that are stained with combinations
of up to four different fluorescent dyes or antibodies specific
for various cellular markers. This application note gives a 

concise method of staining cellular DNA with propidium
iodide and phosphorylated histones for a detailed cell-cycle
analysis using the BD FACSArray bioanalyzer. 

A P P L I C A T I O N N O T E

This Application Note describes a method for using the BD FACSArray™ bioanalyzer to analyze cells stained for cell-cycle
analysis using propidium iodide and an additional intranuclear stain for multiparameter analysis. 



The cell-cycle (aka, cell division cycle) consists of a series of
processes involved in the growth, replication, and division of
cells. The cell-cycle can be divided into two major stages,
interphase (a phase between mitotic events) and mitosis. There
are three distinct, successive stages within interphase, called G1,
S, and G2 phases. During G1 (first gap), cells monitor their
environment and grow (synthesize RNA and proteins). If
conditions are right, cells commit to DNA synthesis (S phase)
and replicate their chromosomal DNA. A G2 phase (second
gap) follows in which cells continue to grow and prepare for
mitosis (division). The G2 gap allows time for the cell to
complete its DNA replication before initiating mitosis. In
mitosis, there are four successive phases:

• prophase–marked by chromosomal condensation,
dissolution of the nuclear membrane and spindle
formation 

• metaphase–chromosomal alignment along the metaphase plate 

• anaphase–separation of chromosome pairs into opposite
poles of the cell

• telophase–creation of two nuclei, accompanied by
cytoplasmic division (cytokinesis) giving rise to two
daughter cells. 

Upon completion of the process, each daughter cell contains the
same genetic material as the original cell and roughly half of its
G2 level of cytoplasm.

In addition to these specific stages, the G0 phase has been
described for cells that exit from the cell-cycle and enter a
quiescent, nondividing state. In response to external stimuli,
some cells may undergo reactivation and express early response
genes. These cells can leave G0 and enter the G1 phase of the
cell-cycle (G0–G1 transition) that is marked by cell growth (ie,
blast transformation due to measurable increases in RNA and
protein synthesis). Another consequence of cellular activation
may be the induction of programmed cell death (apoptosis).
Together, through the counterbalancing processes of cell
proliferation and apoptosis, and the establishment of quiescent
or nondividing states, appropriate numbers and various types
of somatic cells (including cells of the immune system) are
dynamically maintained (homeostasis) throughout the body’s
life cycle. 

Figure 1. Flow Cytometric Analysis of Cellular DNA Content

Using fluorescent nucleic acid dyes, such as propidium iodode,
it is possible to identify the proportions of cells that are in one
of the three interphase stages of the cell-cycle by using flow
cytometry to measure their relative DNA content (Figure 1).
Cells that are in the G0/G1 phase (before DNA synthesis) have
a defined amount (1×) of DNA (ie, a diploid chromosomal
DNA content). During S phase (DNA synthesis), cells contain
between 1× and 2× DNA levels. Within the G2 or M phases
(G2/M), cells have a 2× amount of DNA (ie, a tetraploid
chromosomal DNA content).

Immunofluorescent staining of phosphorylated histones may 
be used with propidium iodide staining and flow cytometric
analysis to further resolve cells within the G2 or M phases.
Cells that express phosphorylated Histone 3 at serine-28 are in
the M phase. Phosphorylated Histone 3 can thus be used as a
cell-cycle marker for screening for affects to the M phase of the
cell-cycle pathway. This experiment will utilize Anti Histone H3
(pSer28)-Alexa Fluor® 647 as the Phospho Histone 3 antibody
to investigate the affects of a specific compound upon the M
phase. The ability to simultaneously and rapidly analyze
samples for their cell-cycle status and intracellular signaling
markers makes this assay ideal for high content screening.

This application note describes a method for staining and
analyzing cells for cell-cycle analysis using the BD FACSArray
bioanalyzer. This procedure includes optional steps for how to
perform further research of intracellular, intranuclear, or cell-
surface proteins along with cell-cycle analysis. Before you begin
this procedure, review the entire Methods and Protocols section
to familiarize yourself with the steps involved. Review the 
BD FACSArray™ Bioanalyzer User’s Guide, especially Chapter
7, for a detailed explanation of how to set up the instrument
for cellular applications.

Fluorochromes to Use with the BD FACSArray™

Bioanalyzer
The BD FACSArray™ bioanalyzer has a green laser at 532 nm
wavelength and a red laser at 635 nm wavelength. Fluorescent
emissions from fluorescent dyes or fluorochromes excited by
the green laser are detected with the Yellow and the Far Red
detectors, while fluorescent emissions excited by the red laser
are detected by the Red and NIR detectors.

Fluorochromes that can be used with ethanol-fixed cells
stained with propidium iodide (PI)

FLUORESCENT PARAMETER FLUOROCHROME OR DYE LASER

Yellow Propidium Iodide Green

Far Red Propidium Iodide Green

Red APC or Red
Alexa Fluor® 647

NIR - Red

Propidium Iodide

Propidium iodide (PI) is the most widely used fluorescent dye
for staining DNA in whole cells (or isolated nuclei). PI
intercalates into the DNA helix of fixed and permeabilized
cells. Because PI can stain both double-stranded RNA and DNA,
cells must be treated with RNase to ensure that PI staining is
DNA specific. PI does not cross the plasma membrane of viable
cells. However, it can readily enter dead cells (or cells in late
stages of apoptosis) that have damaged plasma membranes and
can stain their cellular DNA. 

G0/G1

S G2/M
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Materials
REAGENT CAT. NO

BD Pharmingen Stain Buffer (FBS) 554656

96-well U bottom plate BD Falcon 
353910

RNase Sigma R-5500

Propidium Iodide Sigma P-4170

ModFit LT™ Software for PC *349329

Anti Histone H3 (pSer28)-Alexa Fluor® 647 inquire

Nocodazole Sigma M-1404

*BD Biosciences Immunocytometry Systems

Methods and Protocols
Protocol for Staining DNA with Propidium Iodide for Cell-
Cycle Analysis Using the BD FACSArray™ bioanalyzer.

The protocol in this application note includes optional steps on
how to perform intracellular, intranuclear, or cell-surface
staining for further cell-cycle and cellular analysis. Please review
the outline for the appropriate steps for your experiment. 

Outline of Sample Preparation Steps

Cell-Cycle Experiment

1. Perform cell surface staining (optional)

2. Fix cells

3. Perform intracellular or intranuclear surface staining
(optional)

4. RNase treatment

5. PI stain

6. Acquire and analyze cells on the BD FACSArray
bioanalyzer

Depending on the experiment that will be run on the BD FACSArray
bioanalyzer, the cells will have to be prepared in a specific pattern
in the 96-well plate. The following example will demonstrate a
method for performing a two-color experiment, using PI and
Alexa Fluor® 647. With this two-color experiment, specific
setup wells need to be prepared to set up and optimize the
instrument. If cell-cycle alone is being run, there is only one
color being detected and thus no set-up wells are necessary.

The cell-cycle analysis experiment described here used DNA 
stained with PI for a general cell-cycle analysis and Anti
Histone H3 (pSer28)-Alexa Fluor® 647 to distinguish M phase
cells in the cell-cycle. For demonstration purposes cells were
arrested with 1 µg/mL of Nocodazole for 4 hours prior to
harvesting to allow for cells to be arrested in the M phase.

Sample Preparation
Prepare the 96-well sample plate as follows:

• Well A1: unstained control sample 

• Well A2: PI stained control sample 

• Well A3: Alexa Fluor® 647 only control sample 

• Well A4: PI and APC or Alexa Fluor® 647 stained cells
together for the complete cell-cycle analysis

TIP: Additional samples used in the setup wells may be needed for
the first time this assay is performed. Prepare additional
volumes according to your needs. 

Cell-Surface Staining (Optional)
Cells may be stained for surface antigens prior to fixation with
ethanol (EtOH). Because PI emits fluorescence in both the
Yellow and Far Red channels upon excitation, antibodies
conjugated with the fluorochromes phycoerythrin (PE) or PE-
cyanine dye Cy7 (PE-Cy7) should not be used. Fluorescent
antibodies conjugated to allophycocyanin (APC) or Alexa
Fluor® 647 are the recommended conjugates for two-color
staining with PI when using EtOH-fixed cells. 

Note: APC-Cy-7 conjugates are not recommended
for use with EtOH-fixed cells. Cells may be
stained prior to EtOH fixation by adding an
appropriate concentration of APC- or Alexa
Fluor® 647 conjugated antibody to the cells.
Each researcher should determine if the
experimental antibody will work with
EtOH-fixed cells. EtOH can destroy certain
fluorochromes and antigenic epitopes on
cells. 

Note: If the antibody has been shown to stain
EtOH -fixed cells, then staining may be done
post EtOH fixation. 

1. Incubate the cells for 15 – 30 minutes on ice at 0 – 4°C 
then wash using BD Pharmingen™ staining buffer 
(BD Pharmingen™ Stain Buffer (FBS) or 1× Dulbecco’s 
PBS, 3% FCS, 0.09% NaN3, pH 7.4). 

2. For cells that must be stained prior to EtOH fixation, stain
the cells according to the manufacturer’s protocol. 

3. Wash cells in staining buffer before proceeding to the
fixation step.

Fixation of Cells
Cells are fixed using ice-cold 70% EtOH. Cells may be fixed 
in bulk then transferred to a 96-well U bottom plate or the 
cells may be fixed in the plate directly. Both procedures are
described below. 

A. Bulk Cell Fixation

1. Wash cells twice with 1× PBS to remove any residual
media or buffers that contain FBS or BSA. It is important
so as to avoid aggregates, which can clog the instrument
during analysis. Add 100 µL of 1× PBS per 1 × 107 cells
and resuspend the cells by vigorous vortexing. 

2. Add 5 mL of ice-cold 70% EtOH by dropper while slowly
mixing or vortexing. Additional EtOH may be added to
adjust cell concentration to 2 × 106 cells/mL. This volume
may be added without vortexing. 

3. Incubate the cells with EtOH for at least 1 hour at or
below 4°C. Cells may be incubated overnight and 
are stable at –20°C for weeks.

4. Prior to staining, resuspend cell pellets and check for
aggregates prior to transferring to the 96-well U bottom plate.

• If any aggregates are present, filter the cell suspension
through a 60 µm pore nylon mesh. 

5. Transfer the sample to a 96-well U-bottom plate at 
≤ 5 × 105 cells per well.
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B. Cell Fixation in Plates with U Bottom Wells

1. Add ≤ 5 × 105 cells per well. 

2. Wash the cells twice with 100 µL 1× PBS to remove any
residual FCS or BSA.

3. Fix cells by adding 10 µL of 1× PBS to each well followed
by 100 µL of 70% ice-cold EtOH. 

4. Incubate cells for at least 1 hour at or below 4°C.

5. Wash the cells twice with 100 µL 1× PBS. Pellet the cells
by centrifugation at 300 × g for 5 minutes.

Intracellular, Intranuclear, or Surface Marker
Staining (Optional)

1. If they are to be stained for intranuclear markers such as
Phospho Histone, treat EtOH-fixed cells with 0.1%
Tween-20 in 1× PBS for 20 minutes at room temperature.

2. Wash cells in staining buffer, then stain with the appropriate
concentration of antibody for 20 minutes at room
temperature. 

3. Wash cells in staining buffer. 

4. Pellet the cells by centrifugation at 300 × g for 5 minutes,
then aspirate supernatants from the wells. 

5. If a secondary staining step is needed, stain the cells with
the appropriate amount of secondary step antibody
according to the manufacturer’s protocol.

6. Wash the cells in staining buffer, and aspirate the
supernatant from the wells. 

7. Do not resuspend the cells. Proceed directly to the RNase
treatment. 

RNase Treatment
Propidium iodide (PI) is not a DNA-specific dye. PI stains all
nucleic acids including RNA. Therefore, treatment with RNase
is necessary to ensure specific staining of DNA by PI.

1. Add 50 – 100 µg of a working concentration of RNase in 
1× PBS to each well. A working concentration of RNase
can be made by diluting the stock of 1 µg/µL in 1× PBS
and stored at –80°C.

2. Incubate at 37°C for 30 minutes.

3. Wash the cells in staining buffer and aspirate the
supernatant from the wells. 

4. Resuspend wells A1 and A3 in 200 µL staining buffer. Do
not resuspend the cells in wells A2 or A4, but proceed
directly to the DNA staining step. 

Staining for DNA
The protocol below specifies volumes needed for staining two
wells with PI. Adjust the volumes according to the number of
wells in your experiment.

PI stock is diluted to 1 mg/mL in H2O and stored at 4°C in the
dark.

1. Dilute 15 µL of PI stock (1 mg/mL) in 585 µL of staining
buffer.

2. Add 200 µL of diluted PI solution at 5 µg/sample to each
of the following wells: 

• A2: PI setup well

• A4: Investigation well

Cell-Cycle Analysis with the BD FACSArray™

Bioanalyzer
The BD FACSArray™ bioanalyzer aspirates cell samples from 
a 96-well plate during flow cytometric analysis; the maximum
sample volume that can be aspirated at one time is limited to
approximately 100 µL per well. Additional volume should be
added to the wells to allow for instrument setup. 

It is important to prepare the cell samples according to the
above procedure so that the wells are correctly laid out in the
plate for easy acquisition by the BD FACSArray bioanalyzer. 

Before setting up the controls and instrument optimization for
spillover (compensation), create a new experiment through the
Experiment Wizard. 
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Creating an Experiment using the
Wizard

The Experiment Wizard allows you to
create an experiment by answering a
series of questions. Each wizard session
can be saved and re-opened for a similar
experimental setup at a later time. The
following information is saved in each
Experiment Wizard session:

• sample and well information

• template used

• fluorophore labels

• custom keywords (if any selected)

1. Click the Experiment Wizard tool 

( ) in the application toolbar
(Figure 1). The Experiment Wizard
Welcome dialog appears. The view
remains for approximately 2 seconds
and then automatically advances to
the next view (Figure 2). 

2. Choose the Default Wizard session
when creating an experiment session
for the first time; click Next.

• The Template view appears
(Figure 3). 

Choosing a Template

The Template view in the wizard 
session allows you to choose one of 
the predefined templates provided for
cellular applications. The templates
contain default loader and instrument
settings that serve as a starting point for
sample setup and optimization for an
immunophenotyping application. Each
predefined template contains a specific
number of plots for acquisition and
analysis of data. 

1. Choose the 2 Color template from
the Template drop-down menu;
click Next.

• The Instrument Setup and Optical
Spillover view appears (Figure 4).
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Figure 1. Experiment Wizard

Figure 2

Figure 3



Entering Sample Information

For cellular experiments, you must add
setup wells if you want the software to
automatically calculate optical spillover.
A setup well will be added for each
color of this experiment. 

The names used within this experiment
are examples. Customize the names for
your own particular experiment. 

1. Click the Yes radio button to enable
the color selection checkboxes.

2. Click in each checkbox for the
colors to be used. 

Note: Click Yellow for PI and Red for
Phospho Histone-Alexa Fluor® 647 

Note: When you choose to add setup wells
to your experiment, an unstained well
is also added. The unstained well is
run before the other setup wells. For
this 2-color experiment, a total of
three setup wells will be added.

3. Click Next.

The Number of Samples view
appears.

4. Enter the number 1 for the sample
in A4 that will be analyzed for this
experiment; click Next.

• The Sample Identification view
appears.

5. Leave the default the sample name,
Sample_001, for each sample in the
Sample Identification view. 

Entering Well Information

1. Click Next.

• The Number of Wells per Sample
view appears.

2. Leave the default 1 well per
sample; click Next.

• The Well Names View appears
(Figure 5).

3. To identify the investigation well,
enter the name of the antibodies
that are in this well.

• In this example, enter Cell-Cycle
as the name for Well 1.

• To enter text in the text field:

• Double-click in the white area of
the text field to highlight the
existing entry.

• Type the new name.

• Press the Enter key on your
computer keyboard.

TIP: Click the tab button to easily move
between text fields.

4. Click Next.

• The Fluorophore Labels view
appears (Figure 6). The labels
will appear as axes labels in the
plots displayed in the Template
view.
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5. Enter the following names for the
Yellow and Red parameters: 

• Propidium Iodide (for Yellow)

• Phospho Histone (for Red) 

Choosing Additional Options

1. Click Next.

• The Custom Keywords view
appears. Do not add keywords in
this Wizard session.

2. Click Next.

• The Adjusting Plate Layout view
appears (Figure 7). In this view,
you can choose how to lay out
samples on the plate. 

3. For this experiment, choose
Contiguous Horizontal from the
drop-down menu, and 0 as the
number of separators.

Specifying Loader and Acquisition
Settings

1. Click Next.

• The Loader Settings view appears
(Figure 8). 

2. Change the Sample Flow Rate 
from 2.0 to 0.5 µL/sec and leave
the remaining settings as default;
click Next.

• It is important to use the lowest
flow rate when acquiring cell-
cycle samples to achieve the most
accurate measurement. 

• The Acquisition Settings view
appears, (Figure 9) where you
can choose how many events per
well to acquire and whether to
use a stopping gate.
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3. Choose the acquisition settings.

• Click the arrow next to the Events
To Acquire field and choose 20,000
events from the drop-down menu. 

Note: When analyzing cell-cycling data
files in a cell-cycle software, like
Verity’s ModFit LT™ software, it is
preferable to save a data file with at
least 10,000 events excluding debris
and aggregates. Customize the events
to acquire for your experiment

• Choose All Events as the 
stopping rule. 

4. Click Next.

• The Experiment Name view
appears (Figure 10).

Saving Experiment and Wizard Session

1. Type in Cell-Cycle Phospho Histone
Experiment as the name of the
experiment.

2. Click Next.

• The Saving Wizard Session view
appears where you can choose to
name and save the Wizard session.
Saving the Wizard session allows
you to reuse the session for other
similar experiments. You may
modify these settings as needed at
a later date.

3. Click the Yes radio button and enter
the name Cell-Cycle Phospho Histone
Wizard for this wizard session;
click Next. 

• The Completing the Experiment
Wizard summary view appears
(Figure 11).

4. Review the choices that were made.

5. Click Finish.

• The experiment that has just has
been created opens in the Prepare
workspace.

TIP: Go to the application toolbar and
select “Reset Positions” under the
View menu to see the workspace.
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Review the Experiment in the
Prepare Workspace

1. In the Prepare workspace (Figure 12),
review your plate layout. Click the 

Prepare  tool ( ) in the tool bar
to choose the Prepare workspace. 

Note: The first three wells in the plate
view have been designated as setup
wells. These wells will be used to
optimize instrument settings and to
calculate automatic optical spillover
correction by the software. 

2. Click well A1.

3. In the Inspector, choose the Acq.
Tab, and then increase the sample
volume from 20 µL to 100 µL (the
maximum value) by typing 100;
press Enter.

• Increasing the sample volume for
the setup wells allows you to
view live events for a longer
period of time while optimizing
instrument settings.

4. Repeat steps 2 – 3 for the remaining
setup wells (A2 and A3). 

5. Click the Save button ( ) to
save the work.
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Preparing for Instrument Optimization

Preparing the Plate

TIP: Use a printout of the plate view as a guide for transferring
prepared samples to the 96-well plate.

1. Print the plate view of the experiment by clicking the Print
button in the upper right corner of the Prepare workspace.

2. Ensure that there is approximately 200 µL of the prepared
samples in each of the following well.

• Unstained sample in well A1

• PI stained sample in well A2

• Phospho Histone-Alexa Fluor® 647 stained sample in
well A3

• Investigation sample in well A4

Loading the Plate

1. Click the Setup tool in the application toolbar to open the
Setup workspace.

• The wells you selected for acquisition appear in the plate
view, and the setup wells are numbered in the acquisition
order.

2. Place the plate containing the stained samples on the 
plate holder.

• Position the plate so that well A1 is over the A1 mark on
the plate holder.

3. Click the Load button in the Plate Control group.

• If no lid is detected on the plate, the plate is completely
retracted into the bioanalyzer.

• The Status box should display the Instrument Ready
Plate Loaded message.

Optimizing Instrument Settings

Next, you will perform the following steps to optimize settings
for your 2-color cellular sample.

• Adjust Forward Scatter (FCS), Side Scatter (SSC), and
threshold.

• Gate the population of interest.

• Adjust parameter voltages.

• Save data for all the setup wells.

• Calculate optical spillover.

Setup Tool

Figure 12



Optimizing FCS, SSC, and Threshold
Settings

To perform this set of optimization steps,
you need to view data only from the
first well.

1. In the Select Control group, click
None to deselect the wells, and
then click well A1 (Figure 13).

2. Click the Setup button in the
Acquisition Control group.

• Events appear in the plots, but
data is not being saved.

3. Adjust the FSC and SSC voltages to
place the cell population on scale
and above the noise level in the
FSC vs SSC plot, if needed. 

• Adjust the signal for events
displayed in plots by changing
voltage settings.

1. Click the Parameters tab in the
Instrument frame to display the
Parameters pane. (Figure 14)

2. Click in the Voltage field to edit
this setting. Voltages can be adjusted
from 1 – 1,000 by using the up or
down arrows or the slider bar, or
by entering a value in the field.

3. Press Enter on your computer
keyboard to save the changes once
the appropriate scatter profile is
achieved.

4. Adjust the threshold to eliminate
debris at the lower end of the
forward scatter (FSC) scale. 

• Click the Threshold tab in the
Instrument frame to display the
Threshold pane (Figure 15). 

• Click in the Value field to edit the
settings.

• Events below the threshold value
are excluded.

• Press Enter on your computer to
save the changes.

• Press the Set Up button to stop
acquisition of sample from the 
A1 well. 

TIP: If it is difficult to find the population
of interest in the PI histogram, the
threshold parameter can be changed
to the Yellow parameter. This will
allow for the PI stained sample to
be more easily visible. 
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Gating the Population of Interest

The next step is to adjust the gate to surround the cells of
interest, while excluding debris. This ensures that only the
cellular population is viewed while optimizing fluorescent
settings. You may need to readjust the gate for each of the
single-color setup wells.

1. In the Select Control group, click None to deselect the
wells, and then click A2. 

2. Click the Setup button in the Acquisition Control group.

• Events from well A2 appear in the plots, but data is not
being saved.

3. If the gate does not surround the cell population, click on
the gate in the FCS vs SSC plot and drag it to the cell
population. 

Note: The histogram plot displays only gated
events.

Optimizing Fluorescence Settings

For cell-cycle experiments the goal for optimizing fluorescence
settings for the DNA is different from the goal for optimizing
fluorescence settings for intracellular, intranuclear, or cell-surface
staining. For cell-cycle optimization, the DNA profile must be
optimized to adjust the G0/G1 peak to appear around channel
50. Adjusting the G0/G1 population to channel 50 will allow
for the ability to detect varying amounts of DNA that may be
present in some samples. 

For intracellular, intranuclear, or cell-surface staining, the goal
is to ensure that the brightest stained cells do not appear off-
scale while the dimly fluorescent cells remain on-scale. For
optimum sensitivity, the brightest and dimmest populations
should be as well separated as possible while keeping both 
on scale. For optimum resolution of dim populations, keep 
the mean channel of dimly stained (not unstained) populations
above channel 300.

1. In the Parameters tab of the Instrument frame, deselect the
Log checkbox for Yellow. 

• The Yellow parameter will change to a Linear display. 

• DNA measurements must be displayed on linear scale in
order to be able to clearly distinguish between the cell-
cycle phases. This will allow for the PI stained cells,
measured in the Yellow parameter, to be displayed on
linear scale. 

2. While observing the DNA histogram, adjust the Yellow
voltage if necessary to place the G0/G1 population to
around channel 50. 

Note: You do not need to adjust the interval gate
at this time.

3. Click Setup to stop acquisition.

4. In the Select Control group, click None to deselect the wells,
and then click A3 to view the Phospho Histone setup well.

5. Click the Setup button in the Acquisition Control group.

• Events from well A3 appear in the plots, but data is not
being saved.

6. While observing the Red histogram, perform the
following:

• Adjust the Red voltage if necessary to place the brightest
population on scale.

• Verify the dim fluorescent cells remain on scale. 

Deselect 
Log
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7. Click Setup to stop acquisition
(Figure 16).

8. Click the Save button ( ) to
save your work.

Customizing the Loader Settings for
Setup Wells

You have adjusted the instrument
setting for the cellular experiment.
Before acquiring the setup wells, you
will adjust the loader settings for the
sample volume to ensure optimal sample
acquisition. Decreasing the sample
volume for the setup wells allows you to
speed up acquisition and ensure that the
aspirated sample volume does not
exceed the available volume. 
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1. Click the Prepare tool ( ) in the application toolbar to
open the Prepare workspace.

2. Click well A1; change the sample volume in the inspector
from 100 µL to 20 µL; press Enter.

3. Repeat step 2 for the remaining setup wells (A2 and A3).

TIP: Always verify that you have enough volume in the wells prior
to acquisition by unloading the plate and visually inspecting
the volume. A minimum volume of 50 µL is recommended for
this experiment. 

Acquiring Data to Calculate Optical Spillover

The last step is to save the setup well data so that the software
can use the data to automatically calculate and apply optical
spillover correction.

1. Click the Setup tool in the application toolbar to open the
Setup workspace. 

2. In the plate view, verify setup wells A1 – A3 are selected. 

3. Click Acquire.

• Data will be saved for all three wells. After the last setup
well is saved, the software automatically calculates and
applies optical spillover correction. 

• If optical spillover correction was successfully calculated,
the following message appears.

Ensuring Gates Were Properly Set

1. Click the Analyze tab in the Plate Editor. 

2. Click the first well in the plate view and then examine the
plots in the Template view.

3. If needed, perform the following:

• Click on the gate (P1) in the FCS vs SSC plot and drag it
to the cell population while gating out debris.

• Adjust interval markers in each histogram to enclose the
negative population.

4. Click in each of the remaining setup wells and verify:

• The gate in the FCS vs SSC plot surrounds the cell
population.

• Interval gates enclose the positive population in each
fluorescence parameter 
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• For the PI positive well, adjust the Interval gate to
encompass the entire cell-cycle population. 

• For the Red positive sample, adjust the Interval to be
around the positive cells. 

5. If you adjusted any of the gates in this section, choose
Instrument > Calculate Spillover to recalculate the optical
spillover.

6. Click the Acquire tab in the Plate Editor.

7. Click the Save button ( ) to save your work. 

Data Acquisition

1. In the Select Control group, click the Auto button.

• The remaining sample well (A4) will become selected
and will be labeled as number one. The number in each
well indicates the run order. 

2. Click the Acquire tool in the application toolbar to open
the Acquire workspace.

3. Click the Acquire button in the Acquisition Control group.

• After a short pause, the following occurs:

• An orange ring appears in the well selected for
acquisition, indicating that sample is being acquired.

• Events appear in the plots.

• Data is saved.

4. Click the Acquisition Status tool ( ) in the application
workspace to open the Acquisition Status frame. 

5. In the Acquisition Status frame, monitor the event rate to
ensure that events are being detected and acquired.

6. Once the plate has been acquired, click the Unload button
in the Plate Control group to eject the plate from the plate
sampler. 

7. Remove the plate from the Plate Holder. This completes
sample acquisition.

Data Analysis Using BD FACSArray™ Software
BD FACSArray™ software can perform cell-cycle analysis
estimating the percentage of cells in each cell-cycle compartment.
A more accurate cell-cycle analysis should be performed with 
a cell-cycle modeling software, such as ModFit LT™ software.
Cell-cycle software uses algorithms that correctly model the
three cell-cycle compartments and is able to analyze the overlap
that occurs between the G0/G1, S, and G2/M phases. In addition,
cell-cycle modeling software provides a more accurate analysis
by subtracting out underlying debris and aggregate cells that
may interfere with the measurement of the cell-cycle compartments,
thus determining an accurate percentages of cells in each cell-
cycle phase. 

Use the analysis features in BD FACSArray software to create
an estimate of the percentages in each cell-cycle compartment
as a starting point for your analysis. Perform further analysis in
a third-party cell-cycle modeling software for a more complete
analysis.
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Create a Gate

1. Click on the Analyze tool ( ) in
the application toolbar to open the
Analysis workspace (Figure 17). 

2. Display data from the sample well
by clicking on well A4.

• In the template, the plots display
the stored data from the selected
sample well. 

3. Click on the Snap-To Auto polygon
gate in the template toolbar.

4. Click on the cell population in the
FCS vs. SSC plot.

• A Snap-To gate will be
automatically created around the
population. This gate will be used
to gate out the debris.

Snap-To
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TIP: The P1 gate can be adjusted or moved if necessary. To adjust
the position of the gate, click and hold on the gate and drag it
to the new position. To adjust the shape of the gate click on
the gate first, then click, hold then drag the vertex point you
want to move.

5. To display only gated data in the fluorescent plots perform
the following:

• To select multiple plots, click on the border of the plots
while holding down the Shift key.

• Right-click on the border of one of the selected plots.

• Choose Show Populations, and then select P1 from the
menu that appears.

• Only the cells that are in gate P1 will now appear in the
fluorescence plots.

6. Zoom in on the cell-cycle histogram to more easily
identify the cell-cycle compartment.

• Click on the magnifier glass button ( ) to zoom in on
the cell-cycle population displayed in the Yellow
parameter.

• Click and drag across the population in the Yellow
parameter to enlarge the view.

7. Create three interval gates on the three cell-cycle
compartments: G0/G1 peak, S-phase, and G2/M peak.

• In the template toolbar, click on the interval gate tool 

( ) to select an interval gate.

• Click and drag the gate across the G0/G1 population in
the Yellow parameter. 

• Repeat the steps for creating the interval gate (P3) to
surround the S-phase cells.

• Repeat the steps for creating the interval gate (P4) to
surround the G2/M population.
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• The statistics for each population will be displayed in the 
statistics view.

8. Analyze the Phospho Histone positive cells to determine
the percentage of cells in the M-phase of the cell-cycle. 

• Click on the rectangle button( ) to select it.

• Click and drag the rectangle around the Phospho
Histone positive population. 

• The statistics for P5 will be displayed in the statistics view.

9. Review the statistics to get an estimate of the percentage
of cells in each cell-cycle compartment. 

• The PI histogram determines the percentage of cells in
the G0/G1, S, and G2/M phases of the cell-cycle.

• The Phospho Histone positive cells determine the
percentage of cells in the M-phase only. 

Estimated percentages of the cell-cycle compartments are
determined by BD FACSArray™ software as follows:

• P2 estimates the G0/G1 percentage 

• P3 estimates the S-Phase percentage 

• P4 estimates the G2/M percentage 

• P5 estimates the phospho histone M-phase percentage 

These percentages are only estimate the cell-cycle phases; they
are based on the interval gates that were set in the histogram.
Since the cell-cycle phases overlap, using interval gates does not
accurately determine the percentage of cells in each cycle.

Cell-Cycle Analysis Using ModFit LT Software
Cell-cycle analysis is more accurately performed by a cell-cycle
modeling software by applying specific models to the cell-cycle
phases to account for the overlap in the phases. Data files must
be exported from BD FACSArray software to be analyzed in 
a third-party cell-cycle analysis software. For more detailed
information on ModFit LT software, refer to the ModFit LT
user guide. 

Exporting Data from BD FACSArray™ Software

1. In the BD FACSArray™ software, click once on your 
cell-cycle experiment icon in the browser to select the
experiment that contains the data files to be exported. 
(Do not double-click to open the experiment).

• If you performed the experiment described in this
Application Note, click on the Cell Cycle Phospho
Histone Experiment icon in the Browser.

2. Go to the File menu and choose Export -> FCS.

3. Choose the FCS files to be exported as FCS 2.0 files.

• The files will be exported to the D:\BDExport\FCS folder
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ModFit LT™ Software

1. Open the ModFit LT™ software application.

2. Log in as a standard user.

3. Open a file by clicking the File button or by using the pull-
down menu under File. 

4. Navigate to the D:\BDExport\ FCS folder to locate the cell-
cycle data file that was exported from the BD FACSArray™
software.

5. Click on the FCS data file and click Open.

• The Choose Parameter For Analysis dialog appears.

6. Choose Yellow-Area as the parameter for analysis.

• The Define Gates dialog appears.

7. Leave the gates unselected and click OK.

• Verity recommends allowing ModFit LT software to
automatically detect the debris and aggregates, thus
creating a gate is not necessary.

8. Click on the Choose Model (Mod) button from the tool
bar or using the pull down menu under analysis

9. Set the properties for Manual Analysis. 

• Go to Edit-> Properties for Manual Analysis 

• Change the number of cycles to 1 to create a cell-cycle
analysis for the diploid sample that was run.

• Leave the AutoDebris and AutoAggregates features
enabled to allow for the software to automatically model
and subtract out the debris and aggregates.

• Click OK.

• The software will automatically place the model ranges
over the detected peaks. 

• Adjust the ranges for the G1 peak, S-phase, or the G2
peak only if needed.

10. Click the Fit Data button (Fit) from the toolbar to perform
cell-cycle analysis.

• The software will automatically model the peaks under
the model ranges for the G1 peak, S-phase, and the G2
peak. 

• ModFit LT displays the results of the cell-cycle analysis
in a report (Figure 18). 

Tip

Extra setup wells:

After an experiment is created with the Experiment Wizard,
extra setup or sample wells can be added to the plate layout
using the following steps: 

1. Click to select the Prepare Workspace in the application
toolbar.

2. In the Layout for Plates field of the plate editor, click the
Manual button.

3. Click to select the wells in the plate. Use the Shift key for
multiple selections.

4. Click Add Sample or Add Setup.

• Repeat steps 3 – 4 for all the samples that you are adding.
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